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Abstract 
 
Because of the possible health risks related to the use of nanoparticle technologies in face masks, a 
general methodology is developed for identification, localization and particle size measurement of 
nanoparticles in situ in face masks by conventional and analytical transmission electron microscopy 
(TEM). The methodology can be applied by following this protocol which includes (i) preparation of 
resin-embedded ultra-thin sections of face masks suitable for TEM analysis, a procedure that can be 
applied to any type of textile, (ii) visualization and identification of the (nano)particles inside the cross 
section of the textile fibres by scanning TEM (STEM) combined with energy dispersive X-ray 
spectroscopy (EDX), (iii) measurement of the number-based particle size distribution based on a (semi-
)automatic quantitative analysis using ImageJ, and (iv) in view of risk assessment, a calculation to 
estimate the amount of particles available for release from the mask. 
 

 

  



Introduction 

Since the beginning of the COVID-19 pandemic, face masks are utilized as a public health measure 
worldwide and are being distributed by many different producers/companies. A recent study1 found that 
a large percentage of masks, even though not indicated, contain titanium dioxide which is generally 
applied in commercial textile products as a white colorant or as a matting agent2,3. It was demonstrated 
by Verleysen et al.4 that the titanium dioxide was present in the masks as particles with a fraction in the 
nano-range (<100 nm; median constituent particle size between 89 nm and 184 nm were measured). 
In addition, treatment of textiles with silver or copper based biocides, which gives the textiles a broad 
spectrum of antibacterial and antiviral properties5–7, is applied in certain face masks. Such biocides can 
be applied under different physicochemical forms, one of which being nanoparticles. Many other 
examples of nanotechnology based applications in face masks have been reported.8 However, the use 
of such nanotechnologies in face masks is accompanied by safety concerns as to whether nanoparticles 
may be released and exposing the wearer to nanoparticles upon inhalation9. To perform a risk 
assessment in line with the EU’s regulatory framework, formal identification of the type of particles, their 
localization in the textile and a determination of the (nano)particle size distribution are imperative. 

A general methodology is proposed to evaluate the presence and characteristics of nanoparticles in 
situ in face masks by conventional and analytical transmission electron microscopy (TEM). The applied 
sample preparation, TEM imaging and analysis aim to identify and measure the size, shape, 
agglomeration state and elemental composition of the nanoparticles in ultra-thin epoxy resin sections 
of the face masks. In addition, the amount of (nano)particles at the surface of the textile fibres is 
determined, as this forms an important factor to predict whether release of nanoparticles may occur. 
The method has already been applied by Verleysen et al.4 for quantification of TiO2 nanoparticles in 
face masks for general use on the Belgian market. 

The proposed methodology for preparing TEM specimens from face masks is based on the procedure 
described by Gashti et al.10. Ultra-thin sections of the textiles are prepared by embedding them in an 
epoxy resin, followed by ultra-thin sectioning using ultramicrotomy. The described procedure can be 
applied to different types of textiles including synthetic fibres such as polyester, polyamide, and 
elastane; natural fibres such as cotton; and woven as well as non-woven fabrics. High angle annular 
dark field scanning transmission electron microscopy11,12 (HAADF-STEM) allows to visualize the cross 
section of the fibres and to identify isolated, aggregated and agglomerated (nano)particles based on 
the generated Z-contrast. Elemental analysis by STEM-EDX11,13 (energy dispersive X-ray 
spectroscopy), which detects the characteristic X-rays emitted by the sample upon electron irradiation, 
is applied to determine the chemical composition of the particles. As shown by Verleysen et al.4, TiO2 
appears highly agglomerated in the mask fibres. Therefore, to calculate the fraction of particles at the 
fibre surface, the following quantities are determined: (i) the agglomerate size, which is measured semi-
automatically using the NanoDefine ParticleSizer plugin in ImageJ, (ii) the constituent particle size, 
which is measured manually since individual particles can’t be separated as they are fixed in 
agglomerate form in the matrix, and (iii) the fibre diameter, also measured manually. The amount of 
particles required for the quantitative size analysis is determined according to FprCEN/TS1727314, 
supporting on the relation between the number of measured particles and uncertainty associated with 
the intermediate precision (intra-laboratory measurement uncertainty) of the median minimum Feret 
diameter (Fmin). 
 
 

Reagents 

 
 Vinyl cyclohexene anhydride (NSA, Fluka, 74378) 
 
 DER736 (Fluka, 31191) 

 

 2-nonen-1-ylsuccinic anhydride (NSA, Fluka, 74378) 
 

 2-dimethylamino ethanol (DMAE, Fluka, 38990) 
 

 Epon812 (Fluka, 45345) 
 



 2-dodecen-1-ylsuccinic anhydride (DDSA, Fluka, 44161) 
 

 Methylonorbornene-2,3-dicarboxylic-acid (MNA, Fluka, 68165) 
 

 2,4,6-Tris(dimethyl-aminomethyl)phenol (DMP30, Fluka, 93331) 

 

 Distilled water 

 
 
Equipment 

 
Small laboratory material 
 

 Pioloform-coated and carbon-shaded copper grids 150 mesh (Agar Scientific Ltd., G2150C). 
Home-made and commercially available grids can be used. 
 

 120 mm diameter polyethylene petri dish 
 

 Silicone Mould 21 Cavity Blue (Agar Scientific Ltd., AGG3549) 
 

 Transfer pipettes, Falcon. Capacity 3,0 ml, Length 152 mm. Polyethylene, disposable (VWR 
International, 734-0342) 

 
 Filter papers Ø 70 mm (Whatman, 54 hardened) 

 

 Scotch tape to fix a filter paper in the petri dish 
 

 Permanent, waterproof marker or a ball point to indicate references on filter 
 

 Regular scissors 
 

 Pencil 

 
Large equipment 

 
 EM TRIM2 trimming unit (Leica Microsystems, Diegem, Belgium)  

 

 Ultracut microtome (Leica Microsystems, Vienna, Austria) 
 

 Compact embedding oven, model MINO/6 (Genlab, Widnes, UK) 
 

 Talos 200 kV transmission electron microscope that can be operated in STEM mode, equipped 
with a HAADF detector and Super-X EDX detector (Thermo Fisher Scientific, Eindhoven, The 
Netherlands) consisting of 2 windowless silicon drift detectors (SDD) (Thermo Fisher Scientific, 
Eindhoven, The Netherlands) 

 
Software 
 

 Velox version 3.3.1.19-397c043e56 (Thermo Fisher Scientific, Eindhoven, The Netherlands). 
License needed. 

 

 ImageJ version 1.53f51 (National Institutes of Health, USA). Download available at 
https://imagej.net/downloads. Used plugins: 

o ParticleSizer 
o Max Inscribed Circles 

 
 Anaconda software including the integrated development environment Spyder version 5.1.5 

https://imagej.net/downloads


running Python 3.9. Download available at https://www.anaconda.com/products/individual. 

 

 
Procedure 
 
Safety remarks: 
 

 Because of the possible toxicity of the reagents and materials, and the possible presence of 
unknown contaminants, it is highly recommended to wear gloves during this procedure.  

 
 All waste materials generated during this procedure should be disposed in the suitable 

container for chemical waste. 
 

1 Preparation of Epon medium 

 

 Prepare Spurr solution: Dissolve 13.3 g vinyl cyclohexene dioxide, 7 g DER736, 34.7 g 2-
nonen-1-ylsuccinic anhydride and 0.53 g 2-dimethylamino ethanol in 50 ml of distilled water. 

 

 Prepare Epon812 solution: mix 27.3 g Epon812 , 10.8 g 2-dodecen-1-ylsuccinic anhydride, 18.7 
g methylnorbornene-2,3-dicarboxylic-acid and 0.9 g 2,4,6-Tris(dimethyl-aminomethyl)phenol 
with 50 ml distilled water. 
 

 Mix equal amounts (usually 50 ml) of Spurr and Epon812 solutions. 

 

2 Preparation of TEM specimen from mask 

 

 Use a pair of scissors to cut a 1 cm x 1 cm square from the sample mask. 

 Separate the different layers of textile. 

 Cut a 1 mm x 5 mm piece of each layer. 

 Transfer the layer samples into the silicone rubber embedding mould. Care should be taken 
to give the samples a correct orientation (Figure 1). A small piece of filter paper with the 
required references written on it in pencil is placed in each cup to label the samples. Optional: 
To obtain more of the sample on the grid, 2 pieces of textile can be brought in the same block 
of epon (on top of each other without spacing). 

 

Figure 1: Schematic drawing of the embedding mould with a sample piece of a mask layer inside.  

 Fill the mould with the Epon812-Spurr resin mixture and allow to polymerize for 48 hours at 70 
°C in an embedding oven. Let cool down for 2 hours afterwards. 

 After embedding, trim the specimen block with the EM TRIM2 trimming unit to obtain a cutting 
face of 0.5 x 1 mm2 to 1 x 2 mm2.  

 Cut semi-thin sections with a thickness of 150 nm (interference colour in between gold and 
purple) using the Ultracut microtome. 

https://www.anaconda.com/products/individual


 Bring the sections on carbon and pioloform-coated copper grids (150 mesh). If only TEM 
imaging is performed, the carbon layer on the grid is not necessary. For STEM-EDX analysis, 
the grid has to be coated with both carbon and pioloform to avoid specimen drift.  

 

3 HAADF-STEM imaging of fibres and particles 
 

For HAADF-STEM imaging and EDX analysis, a well-calibrated and well-aligned Talos 
transmission electron microscope operated at 200 kV is used. 

 

 Load the grid into the single tilt/double tilt TEM holder and insert the holder into the TEM. 
 

 Velox will open a window asking to specify the folder where the STEM images/EDX data cubes 
will be automatically saved and to define the concept for the file names.  
 

 Load the appropriate FEG register or set the appropriate probe conditions for imaging beam 
sensitive materials where a large depth of field is needed: Smaller I (e.g. spotsize 9) and 
smaller α (e.g. CA 50 µm; α = 7.5 mrad). 

 
 Adjust the z-height to focus the image and optimize the detector settings in Velox using the 

scope tool. 
 

 Identify the fibres on the grid and record a series of at least 10 well-focused representative 
images of different fibres using the Velox software. Choose the magnification such that the 
fibre cross-section just fits on the image (see Figure 2). These images will be used in section 
5.3 for the determination of the fibre diameter. 

 

 Record a set of images showing particles that are representative for the sample on the TEM 
grid and that are suitable for a subsequent quantitative analysis of the agglomerate and 
constituent particle size. Make sure to capture at least 100 particles (either 
aggregates/agglomerates at lower magnification or constituent particles at higher 
magnification) in line with FprCEN/TS1727314 to assure accurate median size measurements. 
For these masks, typically 10 images both at low and high magnifications is sufficient, although 
this amount depends on the particle density and the size of the aggregates/agglomerates. The 
specific imaging conditions for the imaging in STEM mode are summarized in Table 1. The 
pixel size and the associated lower limit of quantification depend on the selected magnification 
and are determined based on the criterion of Merkus16. The upper size detection limit is limited 
to one tenth of the image size supporting on ISO 13322-1, 2014.17 

 

Table 1: Summary of the STEM imaging conditions applied. 

TEM imaging conditions STEM (Low  Magnif ication) STEM (High Magnif ication) 

Detection system HAADF detector HAADF detector 

Number of images 10 10 

Magnif ication 8000 88000 

Pixel size (nm) 12.25 1.106 

Low er limit of quantif ication (nm) 122.5 11.06 

Upper limit of quantif ication (nm) 12540 1133 

Dw ell time (µm) 20 20 

Size of  the images (px x px) 1024 x 1024 1024 x 1024 
Size of  the images (nm x nm) 12540 x 12540 1133 x 1133 

 

4 EDX spectral imaging (SI) of particles 

 

 Keep the same recording settings as for the STEM imaging, i.e. dwell time 20 µm and image 
size 1024 x 1024 px2. The number of frames is typically set to 5. In case more signal is needed 



to get significant peaks in the EDX spectrum (which might be the case due to the high spot 
size), a higher value is advised. Alternatively, the option to stop the experiment manually can 
be selected. 

 
 Record STEM + EDX SI images of the (nano-)objects of interest. Make sure not to overlook 

particles or aggregates/agglomerates of different elemental composition, particles inside and 
on the border of the fibres and (nano-)objects with special features. Choose an appropriate 
magnification to make sure the object of interest is well-centred in the image with still some 
background space around to allow for some drift between scans. 

 

 By drawing a region on the STEM image using the rectangle tool, the EDX spectrum becomes 
visible. Choose to automatically match the peaks in the spectrum with the elements or add 
elements of interest (e.g. Ti, Ag,…) manually to the energy spectrum or the spectral maps by 
selecting them in the periodic table. 

 

5 Image analysis 

5.1 ParticleSizer for quantitative analysis 

 
The physical properties of the particles of interest are measured based on the properties of their 
2D projections. For constituent particles, the size distribution is determined based on manual 
measurement using ImageJ. For aggregates/agglomerates, the size distribution is determined 
using the NanoDefine ParticleSizer (https://imagej.net/plugins/particlesizer) plugin for ImageJ. This 
method allows determining the properties, such as the characteristic size and shape distributions, 
(semi-)automatically from electron micrographs.  

 
 Open ImageJ and load the image series by File>Open>Image Sequence. Apply the image 

analysis settings summarized in Table 2 on the pop-up window. 
 

 Open the settings manager of the NanoDefine ParticleSizer  plugin by 
Plugins>NanoDefine>SettingsManager. The settings summarized in Table 2 are typically used 
for the analysis of agglomerates of TiO2 in fibres of face masks and can be applied as a starting 
point for further optimization. 

 
 Run the ParticleSizer algorithm pressing Plugins>NanoDefine>ParticleSizer. An image with 

the identified particles overlaid in red, a table presenting the measured properties of the 
detected particles and a histogram of the distribution of the Fmin are generated as output. 
Save the table as csv file. 

 
Table 2: Overview of the image analysis settings of the NanoDefine plugin in ImageJ software for the 

image analysis of agglomerated particles. 

 

Image analysis settings for the NanoDefine plugin in Image J software 

Settings to import image sequences in Image J ☒ Convert to 8-bit Grayscale 

☐ Convert to RGB 

☒ Sort names numerically 

☐ Use virtual stack 

Settings Manager for the Particle Sizer from the NanoDefine plugin  

Mode selection ☐ Use Watershed for irregular structures 

Irregular watershed convexity threshold Not applied 

☒ Use single particle mode 

☐ Use ell ipse fitting mode 

Segmentation Circular window radius Use default 

 Rolling ball radius Use default 

https://imagej.net/plugins/particlesizer


 Min OBT intensity difference (8 bit) 4 

Shape constraints Minimal area (pixels²) 0-10 px² 

Minimal feret min 2-5 pixels 
Minimal convexity 0.45-0.50 

Minimal solidity 0.65-0.70 

Ellipse shape constraints Minimal long axis length (px) Not applied 

Minimal short axis length (px) Not applied 

Maximal aspect ratio Not applied 

Misc Smoothing factor 1-3 

☐ Use inverted images 

☐ Show binary results 

☒ Ask me to select a region 

☐ Do not plot size distribution 

☐ Do not apply denoising 

☐ Record process 

 

5.2 Calculation and visualization of the descriptive statistics 

 
The results of the quantitative analysis of the detected nanoparticles were presented following 
the ISO 9276-1 (ISO, 1998) guidelines for representation of results of particle size analysis. A 
non-parametric approach is applied. For all samples, the normalized number-based distributions 
and the kernel density estimates (KDE) of the Fmin, Fmax, and AR of the constituent particles 
and of the aggregates/agglomerates are determined using the seaborn distplot function. The bin 
width is calculated using Freedman-Diaconis rule18. The mean and median values of the datasets 
are determined. For the KDE plot, producing a continuous density estimate, a Gaussian kernel 
is applied. The modes of the distributions are calculated from the KDE. 
 
Python can be used to process the raw data resulting from the image analysis by ImageJ. Helpful 
packages that can be used to calculate the relevant descriptive statistics and plotting parameter 
histograms are numpy, scipy, pandas and seaborn. Generate a csv file summarizing the 
statistical parameters of the particle size distribution, including the Fmin, which will be used in 
the calculation in Section 6. Alternative software can be applied also. 

 

5.3 Measuring the median fibre diameter 

 

For each of the STEM images of the fibre cross sections, the fibre diameter is determined by 
manual measurement using ImageJ. Since for fibres which are not aligned parallel to the viewing 
direction in the TEM, the cross section appears as an ellipse rather than a circle, the diameter of 
the maximum inscribed circle is selected as the best measure for the fibre diameter. 

 

 Use the polygon tool to draw a shape on the image representing the fibre cross section 

(Figure 2A). 
 

 Click Plugins>BIOP>Image Analysis>Binary>Max Inscribed Circles. 
 

 In the pop-up window, set the minimum disk diameter to 0 and check the box ‘Use selection 
instead of mask’ and click OK. 

 
 The maximum inscribed circle appears on the image as annotation (Figure 2B). Find the 

diameter in pixel by using the circle tool and selecting the drawn circle. 
 

 Covert to nm by looking up the pixel size of the image in Velox and multiplying it with the 
diameter in pixels. 

 



Repeat this for all 10 images of fibres and determine the median fibre diameter (df). 
 

 

Figure 2: Illustration how to use the polygon tool in ImageJ to define the boundary of the fibre (A) and the largest 

inscribed circle inside the polygon selection that gets determined by the Max Inscribed Circles plugin (B). 

 

6 Estimation of the amount of particles at the fibre surface 

 

This estimation is valid on the assumption that the (agglomerated) particles are homogeneously 
distributed in the matrix of the fibres (this is usually the case for TiO2). 
 

 Define 𝐹, the fraction of the particles at the surface of the fibres, as the ratio of an external 
ring-shaped surface of the cross-section of the fibres (Sr) and the total surface of the cross-
section of the fibres (Scs). 

Equation 1: 

𝐹 =
𝑆𝑟

𝑆𝐶𝑆

 

 

 

 The thickness of the external ring-shaped surface, Sr, is determined by the median 
diameter (da) of the agglomerates ( Figure 3). Then, approximate 𝐹, assuming circular 
cross-sections of fibres, as: 

Equation 2: 

𝐹 =

𝜋
4

· 𝑑𝑓
2 −

𝜋
4

· (𝑑𝑓−𝑑𝑎)2

𝜋
4

· 𝑑𝑓
2

 

Equation 3: 

𝐹 =
𝑑𝑓

2 − (𝑑𝑓−𝑑𝑎 )2

𝑑𝑓
2  

with df the median diameter of the fibres (see Section 5.3) and da the median minimum 
Feret diameter of the agglomerates (see Section 5.2). 

 
 Now, calculate the mass of the particles at the surface of the fibres in a mask (𝑀𝑠𝑓 ) as: 

  

Equation 4: 
𝑀𝑠𝑓 =  𝐹 ·  𝑀𝑡𝑜𝑡 

 
with F the fraction of the particles at the surface of the fibres and 𝑀𝑡𝑜𝑡 the total mass of the 

A B 



particles in the mask. The latter quantity can be determined by inductively coupled plasma-
optical emission spectroscopy (ICP-OES) as described in Verleysen et al.4 

 
 
For a specific case of fibres, namely bi-component microfibres, the assumption of a homogeneous 
distribution of the agglomerated particles in the fibres is invalid. Bi-component microfibres are 
characterized by a larger surface area from which particles can be released. To account for this 
increased surface, 𝑆𝑟,𝑚𝑓, a correction factor should be introduced:  

Equation 5: 

𝑆𝑟,𝑚𝑓 = 𝑆𝑟 ·  
∑  𝑤𝑒𝑑𝑔𝑒𝑠  𝑝𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟

𝑓𝑖𝑏𝑟𝑒  𝑝𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟
 

 
With ∑  𝑤𝑒𝑑𝑔𝑒𝑠  𝑝𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟 the sum of the perimeters of the wedge-shaped (nanoparticle 
containing) polyester parts of the fibre, and 𝑓𝑖𝑏𝑟𝑒 𝑝𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟 the perimeter of the (near-)circular 
cross-section of the microfibre. 
 

 

 Figure 3: A schematic representation of the section of the fibre with agglomerated particles (green near-

 spherical shaped). The thickness of the external ring-shaped surface of the cross section (green zone), da, is 
 estimated based on the median v alue of the minimum Feret diameter distribution of the agglomerates. Image 
 taken from Verleysen et al.

4
 

 
 

Troubleshooting 
 
Problem: Particles wrongly identified by ParticleSizer. It is possible that background is also 
identified as particles by the ParticleSizer algorithm and thus some data is wrongly included in the 
quantitative analysis of the particle size. 
 Solution: Manual removal of wrongly detected particles. Draw a rectangle around the wrongly 
identified particles using the “Rectangle” tool to select it, then right click on the selected particle and 
choose ‘Remove particle’. 
 
Problem: Particles not homogeneously distributed in fibre or fibre shape not close to circular. 
In this case, the calculation of the fraction of particles at the fibre surface, that requires a homogenous 
distribution and approximates the fibre as circular, is wrong. 
 Solution: Adapt the calculation of the fraction of particles at the surface (Equation 1:, Equation 2:, 
Equation 3:), taking in account the observed distribution of particles or the fibre shape. 

 



Time Taken  
 
The preparation of a TEM specimen from a mask takes approximately 2 ½ days (time for each specific 
step in the table below). The polymerization and cool down steps can be done for multiple samples at 
the same time. 
 

Table 3: Different steps of the sample preparation and their duration. 

Step Time 

Cut of different layers and introduction of layers in mould 30 min 

Polymerization 48 hours 

Cool down 2 hours 

Trimming 15 min 

Cut of ultra-thin section 20 min 

Total 2 ½ days 

 
 
The STEM-EDX analysis takes approximately 2-3 hours for 1 specimen. 
 
The image analysis can be done in half a day. However for the first time the analysis is done, take into 
account ½ day extra for optimizing the ParticleSizer settings and another ½ day for preparing the python 
script. 
 
The total estimated time of the procedure is approximately 4 days. 

 

 
Anticipated results 
 
At the end of the procedure, STEM and EDX micrographs are obtained which allow both a descriptive 
(size, shape, agglomeration state, elemental composition..) and quantitative (particle size 
distribution) analysis of the (nano)particles present in face masks. The descriptive statistics of the 
important size and shape parameters (Fmin, Fmax, aspect ratio) are summarized and visualized 
using python. In view of a risk assessment, an estimation of the amount of particles available for 
release from the mask is obtained, taking into account the determined fibre and particle properties, 
and their mass. 
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